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Introduction 

This document is meant to give you all needed information about the possibilities of the Er-
goSoft Cut function. Please read this document carefully to make sure, that you can take the 
best possible benefit of using the ErgoSoft Cut function. 

 

Creating/Importing Cut Environment 

For easier access on the cutting functions we recommend to activate the Cut Environment 
tool bar via menu View > Tools > Cut Environment. Please note that you should save the 
workspace in order to restore the changes next time the workspace is loaded after starting 
the ErgoSoft RIP or having switched to another workspace. 

Cut Environments Dialog 

Open the Cut environments 
dialog by clicking on the Cut 

Environments Icon in the Cut Envi-
ronment toolbar or by selecting menu 
Tools > Cut Environments. 

Select Add to open the Add 
Contour Cut Environment 

dialog. The list shown here contains 
all manufacturers of which a cutting 
device is supported. To select a spe-
cific device driver, please click on the 
“+“ in front of the particular manu-
facturer to display the list of the de-
vices. Select the device driver you 
want to use and enter a Name for 
the cut environment. Confirm the driver selection by clicking the OK button. 

If however the selected driver supports different sizes of the selected device, please specify 
the size in the appearing dialog and confirm your selection by clicking the OK button.  
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Cut Environments Settings 

Now the Quality tab of the new cut environment is displayed. Please find a description of the 
available and required settings in the following. 

 
Quality Tab 

In the Quality tab you can set the Speed, Pressure and Accuracy for the cutter. If you un-
check the checkboxes for speed and pressure, these settings will be controlled by the device 
itself. The accuracy specifies the number of points a curve is build with. The higher the accu-
racy the more points and the smaller the steps will be with cost of speed; the lower the accu-
racy the less points and the longer the steps will be with cost of smoothness, curve may have 
unwanted edges. 

Please note that all settings can be changed for each cut path in the cut path settings 
while just speed and pressure can be changed in the Cut Client. 

 
Cutter Device Tab 

The Cutter Device tab allows you to set up a configuration file which contains all the needed 
information to send data to your cutter. These settings can be loaded whenever you create a 
new cut environment for this cutter. 

Create Cutter Configuration File 
To specify the required informa-

tion such as the port used as well as 
port settings, create a new configura-
tion file by clicking the New button. 

Once you have created a cut envi-
ronment, you can edit, delete or re-
name the configuration file using the 
respective buttons. 

Specify Cutter Port 
Click on Add to specify the port 

of your cutter. Select or specify the re-
quired port in the Add Port dialog. The 
available port types depend on the cut-
ter type. 

Specify Folder for Spool Files 
If your copy of the ErgoSoft RIP supports the usage of 

Cut Clients (spooling of cut jobs) you also need to set up a 
spool folder in which the spool files can be saved. 

1 

1 

2 

2 

3 

4 



 

Contour Cutting with ErgoSoft RIPs  3 

1 

2 

3 

4 

4 

5 

When having several systems to prepare cut files for the same cutter with automatic 
barcode support, assigning a different StationId to each system will prevent having 

accidentally printouts from 2 systems with the same barcode. Since the StationId is part of 
the barcode, barcodes from 2 systems with different StationIds will be different any time. 

 
Extended Tab 

The Extended tab allows you to control several settings for the cutting and cutting marks 
configuration. The drivers provided by ErgoSoft do already contain the correct settings for 
the selected devices. Therefore these settings should be handled with caution. 

The Step Size defines the used 
scale unit for the sent commands. 

Most supported cutter drivers allow 
switching between “0.01 mm” and 
“0.025 mm” for the step size. Since “cm” 
and “inch” are supported by some cer-
tain cutters (e.g. MGE i-Cut) only we 
strongly recommend to ensure that it is 
supported by your cutter before select-
ing “cm” or “inch”. 

The Border settings define the 
size of the borders used for a job 

which should also be cut. The drivers 
provided by ErgoSoft do already con-
tain the correct settings for the selected devices. 

Section Scale allows you to do a manual distortion correction. This option is only avail-
able for cutters which do not have an automatic distortion correction. 

Section Marks allows you to specify the size of the cut marks and the distance between 
the cut marks and the image or job (when your cutter supports this configuration). 

When your cutter offers the possibility to frequently print cut marks in order to increase cut-
ting accuracy, you may also enter the distance between the cut marks. 

Section Barcode allows you to activate printing a barcode with the job as well as to 
specify the dimension of the barcode area, the alignment of the barcode in this area, 

and the vertical distance of this area to the job. 
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Production Tab 

The Production tab allows some settings useful for the production itself. 

By default, the cutter will cut the com-
plete job in one step. This means that 
the media will be moved forwards and 
backwards over the complete job 
length. Checking Use Paneling and 
entering a Panel Size will split the job 
into panels so that the media must be 
moved forward and backward just over 
the panel size. When all lines in the first 
panel are cut, the media will be moved 
forward to cut the lines in the next pan-
el. 

Paneling can also be set (but not 
deactivated) for each cut paths. Thus, 
when needing some cut paths with and 
some without paneling, we recommend to specify the paneling in the cut path settings. 

Check Cut in Reversed Order to start cutting at the end of a stack of printed jobs instead 
of at the beginning. This option might be useful for many jobs printed on media already 
rolled to avoid moving the media back at the beginning of the job (e.g. with Summa cutters 
supporting barcode). 

 
Device Options Tab 

Some cut drivers offer additional options which can be found in the Device Options tab. 

 
General Tab 

The General tab allows modifying the name or the description of the cut environment as well 
as the model if the cutter comes in several models. It also shows the basic cut driver the cut 
environment is based on. 
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Creating a Cut Job 

Activating Contour Cutting 

In order to create a cut job and 
to use the selected cut envi-
ronment, you have to activate contour cutting. You can do that by clicking the Con-

tour Cut icon in the Cut Environment toolbar. 

The required borders for the cut marks are automatically added to the media borders so that 
the available job width might be less. Please note that the job width will be limited to the 
smaller value of maximum job width supported by the printer and the maximum job width 
supported by the cutter. 

 
Importing Image 

Preparing the Image in the Design Program 

Use a suitable design program such as CorelDraw, Photoshop, Illustrator, or FreeHand to 
create the cutting paths in the original image, making sure the cutting curve will be able to 
cut the image later. You have several possibilities to define your cut path: Path in CMYK, Clip-
ping Path, or Spot Color Path with the possibility to not print it. When designing a CMYK 
path please keep in mind that it will be also printed and thus, should have a color that is not 
visible in the printout. 

 
CutSample 1: Photoshop Clippath 

CutSample 2: 
rectangle with CMYK path in 100% black 
star with Spot Color outline “Star” 
polygon with Spot Color outline “Polygon” 
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When saving the file as EPS or PDF you have to take care that the cutting paths are not con-
verted. The following example shows the settings for Illustrator CS3/CS4 when saving as EPS 
or PDF file. The relevant setting is hidden in the “Transparency” section of the EPS saving op-
tions as well as in the “Advanced” tab of the PDF (1.3) saving options: 

 
Take care that “Convert All Strokes to Outlines” is not checked to prevent the contours being 
converted into fill paths. 

 
Importing Image 

You can import the image to be cut as all other images. 

 
Editing Job 

You can edit your images in the job as usual. You can rotate, tile, crop, duplicate, mirror etc. 
in the same way as for none cut jobs. 

 

Printing a Cut Job  

Once you have finished the layout of your job, you can print the job on your printer. But be-
fore you print your job it is necessary to decide how the cutting of the job should be 
processed.  

There are basically two different ways to cut a cut job: Cut directly to a port or cut using a Cut 
Client. If the usage of the Cut Client is licensed, you can switch between these two options 
by activating or deactivating the Cut directly to Port (no spooling) option in the Cutter 
Device tab of the active cut environment.  
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Cutting Directly to the Port (no Spooling) 

For cutting directly to the port, the cut process must be launched manually in the JobCom-
poser after having fed the printed job into the cutter. 

Launch cutting by clicking the Cut icon in the Standard 
toolbar or by selecting menu File > Cut. 

In the appearing dialog you can specify which paths should be used as cut path.  

 
Specifying the Cut Paths 

To set up the desired path click the New or Edit 
button. 

This opens the dialog in which you specify the cut path 
settings. Tabs Quality and Paneling (which is only availa-
ble when paneling is not 
activated in the cut envi-
ronment) allow overwriting 
the settings of the cut en-
vironment for the current 
cut path so that e.g. one 
cut path can be configured 
with paneling while all 
other cut paths do not use 
paneling. The device-
dependent tab Cutting 
Tool allows selecting the 
cutting tool for the path. 
The path settings for the 
samples shown above are 
as follows: 
(a) CMYK path named 
“100% Black” 
(b) Clip path named “Pho-
toshop Clip Path” 
(c) Spot color path named “Star” 
(d) Spot color path named “Polygon” 

The color for the CMYK path can be selected using the color selection window opening 
when clicking the button at the right side. Checking Also cut fill paths will not only cut 

stroke paths with the specified color but also fill paths. To avoid problems this option should 
be checked (or unchecked) when the visual path check does not show the correct preview. 
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When having defined a clipping path (e.g. Photoshop Clipping Path) in your image, you 
have to select Clip paths. 

When selecting All paths, all paths which can be found in the image will be cut. This 
option is meant to be used for finding out whether the ErgoSoft RIP can find any cut 

path in the image when the wanted path is not cut. 

When having defined a cut path using a spot color, select Spot Color and enter the 
name of the spot color. Spot color paths is the only colored path type that must not be 

printed. 

Activating Cut Image Borders will cut the image borders. This option is also available 
without any other cut path selection. 

 
Selecting the Cut Paths 

After having specified the cut paths the paths to be ac-
tually cut must be selected. Paths can be added to the list 
and removed from the list. Use the arrow buttons to 
change the order in which the paths are cut. 

 
 
 
 
Displaying the Cut Paths 

Before you send the cut 
command you can display 
the cut path. Therefore click 
on the View button in the 
Contour Cut dialog. In the 
appearing Display cut path 
dialog you can see the paths 
which will be used as cut 
paths. When having selected 
several cut paths clicking the 
View button while the pre-
view window is open will 
scroll through the paths 
displaying the previews of 
the paths one after the oth-
er. 
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Starting the Contour Cutting 

To start the cut process and send the cut command, click the Start button. Your job will now 
be cut according to the defined settings. 

 

Cutting a Cut Job using the Cut Client 

Starting the Printing and Contour Cutting 

If you would like to cut a cut job using a Cut Client, you 
have to make sure that the usage of Cut Clients is li-
censed. Additionally you should assure that you have 
specified the usage of the Cut Client in the cut envi-
ronment by un-checking Cut directly to Port (no 
spooling) on the Cutter Device tab. 

The procedure basically stays the same. Just the order of 
the steps is a bit different: The cutting command is not 
launched separately but combined with the printing 
command. This means that the cutting command itself 
is disabled. 

When launching the Print command, first the dialog for 
printing is displayed. After having adjusted all settings 
and sent the print command by clicking the OK button, 
the Contour Cut dialog is displayed for adjusting the 
cut settings. After having closed this dialog by clicking 
the Start button, ripping and printing is started. The 
complete printing and cutting command can be dis-
carded by clicking the Cancel button in any dialog. 

For a description of the cut path settings and selection 
please refer to chapter “Cutting Directly to the Port (no Spooling)” above. 

 

Starting the Cut Client 

The Cut Client is automatically 
generated using the informa-
tion from the cutter device tab 

of the cut environment. To start a Cut Client click the arrow at the right side of this icon in 
the Cut Environment toolbar and select the Cut Client from the list. 
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Selecting and Starting a Cut Job 

To start a cut job you have to 
set the Cut Client from offline 

to start job manually. 
 

The Cut Client will automatical-
ly select the first job in the 

queue window.  

You can adjust the order by 
increasing or decreasing the 

priority of each job.  

Speed and pressure can be 
changed for each cutting path 

in the job currently loaded. 

If you would like to start the cut job, click the Start button in the Cut Client window.  

 

Using Barcodes to Select a Cut Job 

When having activated the usage of 
barcodes in the Extended tab of your 
cut environment, you can identify a 
cut job by reading its barcode with a 
barcode reader. 

To select a specific cut job check spe-
cify and enter the CutId printed be-
low the barcode or use the barcode 
reader. The Cut Client will automati-
cally select the correct cut job in the cut queue. 
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Using Print & Cut Devices 

Basics 

As it is mentioned in the name of these devices, they are able to perform both the printing 
and the cutting processes. For each of these processes, a device environment must be speci-
fied in the ErgoSoft RIP; a print environment handling the printing process, and a cut envi-
ronment handling the cutting process. 

In general, there are 2 basic workflows for print&cut devices: 
1) The media will be cut immediately before or after printing without having to be removed 

for drying, laminating, or other. 
2) The media must be removed from the device after printing for another process such as 

several hours drying, laminating, etc. Cutting will be done any time later. 
 
The print environment is the same for both workflows. But the cut environment must be dif-
ferent. 

 
Creating the Print Environment 

Create the print environment as usual. 
Make sure that a print&cut driver is se-
lected. Define a printer in the Printer and 
Port tab. You can specify the port and the 
spool folder for the print files there. 

Please note that you have to create a 
print&cut print environment before you 
can create the related cut environment. 
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Creating the Cut Environment 

Make sure that your 
print&cut print environment 

is selected as current print envi-
ronment in the Print Environment 
toolbar. 

Click the Print and cut in one 
device icon in the Cut Environ-

ment toolbar to limit the available 
cutter drivers to the ones suitable to 
the selected print driver. 

Open the Cut Environments 
manager by clicking the Cut 

Environments icon in the Cut Envi-
ronment toolbar. Click the Add but-
ton to add the cut environment. 

The box Print and cut in one de-
vice should be checked in the cut 
environments list as well as the Add 
Contour Cut Environment dialog. 

Select the appropriate cut driver and click the OK button. 

The “Cut after printing” and “Cut before printing” drivers are designed for a workflow in 
which the job is printed and cut in succession without any user intervention. The “using 
marks” drivers are designed for a workflow in which the media is removed after printing and 
cutting is started later manually. 
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Configuring a “Cut after Printing” or “Cut before Printing” Driver 

This type of cut environment does not 
contain any Cutter Device information 
like port or the spool folder since the 
print and cut information is sent at the 
same time using the device specifica-
tions of the active print environment. 
When selecting the “Cut after printing” 
or “Cut before printing” driver, no cut 
marks will be printed. The job will be 
cut automatically directly before print-
ing or after the print job is finished. 

 

 

 
Configuring a “Using Marks” Driver  

This type of cut environment needs 
Cutter Device information like port or 
the spool folder since printing and cut-
ting are two independent steps. When 
selecting the “Using marks” driver, cut 
marks will be printed. The cut job must 
be started manually in the same way as 
for cut-only devices. 

 

 

 

 
Print & Cut a Job on a Print & Cut Device 

To print and cut a job on a print&cut 
devices you simply have to make sure 
that the correct print environment as 
well as the correct cut environment is 
selected. 
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Special Cutting Drivers and Functions 

Mimaki “repeat” / Graphtec “repeat” 

When having selected a Mimaki or Graphtec “repeat” driver printing several copies of a job 
works as follows: All copies of the job are combined in a huge job by duplicating the job in-
cluding the cut marks horizontally and vertically. The result is not treated as a job with e.g. 6 
copies of the jobs but as one job with 6 images. Thus, the number of copies cannot be 
changed in the Print Client or Cut Client. 

 
 
Summa Pharos and S-Class with OPOS 

These cutter drivers allow configuring cut marks along the job length. The additional cut 
marks are also automatically detected by the device when reading the marks. 
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Summa Pharos and S-Class with Barcode 

This type of cutter drivers does not 
use a port. This means that in the 
cut environment configuration, a 
physical port cannot be set but just 
a spool folder. 

The ErgoSoft RIP just create the 
plot data. Then, the CutServer pro-
vided by the cutter manufacturer 
must fetch the file and send it to 
the cutter. 

Since these cutters may roll the 
printed media and find the correct 
cut job using the barcode, checking 
the option Cut in Reversed Order 
on the Production tab is recommended when you want to cut the roll beginning with the 
last printed job and starting to cut from the bottom of the job to the top. 

 
Mutoh Ultima, SC-Pro, Kona with Barcode 

All Mutoh “barcode” cutter drivers 
do not use a port. This means that 
in the cut environment configura-
tion, a physical port cannot be set 
but just a spool folder. 

The ErgoSoft RIP just create the 
plot data. Then, the CutServer pro-
vided by the cutter manufacturer 
must fetch the file and send it to 
the cutter. 
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Eurosystems OptiSCOUT / Zuend Touch and Cut 

Eurosystems OptiSCOUT and Zuend Touch and Cut cutters allow setting the cut marks ma-
nually. The ErgoSoft RIP offer this manual cut mark positioning as an option – in addition to 
automatic positioning of cut marks which is included in the basic cut option. 

Manual cut mark posi-
tioning can be done for 
the selected image by 
selecting Cut Mark Po-
sition from the image 
context menu that is 
displayed when you click 
the right mouse button 
on the image. 

Set the marks by clicking the position in the 
preview window. Remove a mark by clicking 

on it in the preview window. 

To remove all cut marks you can click the Clear button instead of removing each mark 
manually. 

The complete list of marks can be saved and loaded for another image needing the 
same marks. 

Please note that defining the marks manually for one image in a job will discard automatic 
mark creation during printing; you have to set the marks manually for all other images in the 
job, too. 
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MGE i-Cut 

MGE i-Cut cutters allow setting the cut marks manually. The ErgoSoft RIP offer this manual 
cut mark positioning as an option – in addition to automatic positioning of cut marks which 
is included in the basic cut option. It offers all functions described for OptiSCOUT and Zuend 
Touch and Cut above. 

The MGE i-Cut 
driver allows set-

ting the marks auto-
matically related to a 
cut path. Therefore you 
have to define the 
number of marks to be 
set and the path to be 
used. Then, click the 
Generate button to add the marks to the image. 
Additional marks can be added manually. 

 
 
Cutting Stickers 

Some cutters from Summa, Mutoh, and Mimaki offer the possibility to produce stickers very 
easily. They come with a cutting tool that does not cut the complete line but let some small 
parts non-cut so that the parts still stick together but can easily be separated. 

Preparing the Image 

In order to cut the sticker itself as well as to perforate the sticker page you need to create 2 
cut paths of different type: One for the sticker itself and the second where the perforation has 
to go. Since the ErgoSoft RIP offers the possibility to cut the image border, you might not 
need the second “perforation” cut path when you can use the image border instead. 

As long as the sticker itself does not have a printed border you can use a cut path we rec-
ommend to create a Spot Color cut path around the sticker (in the following named Sticker 
Cut Path colored with spot color Sticker) that is not printed. For the “perforation” cut path 
we recommend to either create another Spot Color cut path using a different spot color (in 
the following named Perforation Cut Path colored with spot color Perforation) or to use 
the image border a automatically created cut path. 
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Configuring the Cut Paths 

Sticker Cut Path 

The Spot Color cut path is designed as usual. Take 
care that Do not print the spot color is checked 

when you do not want to print the border around the stick-
er itself. 

Since stickers easily peel off when moving the media 
forward and backward during cutting, we strongly 

recommend activating the paneling for the sticker cut path. 
The other settings can be done as usual. 

 

Perforation Cut Path 

When the perforation cut path is de-
signed in the image as a spot color 

path, the cut path must be configured as a 
spot color cut path as described above. 

When you want to use the image 
border for the perforation cut path, 

make sure to uncheck Path from Image 
Data and to check Cut Image Border to 
just create a cut path from the image bor-
der information in the file (e.g. Bounding Box in EPS files). 

The configuration of the special tool for creating the perforation depends on the used 
cutter type: 
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Cutting the Stickers 

When cutting the stickers we recommend to first cut the 
perforation cut path and then the sticker cut path. 

 

 

 

 
Special Automatic Cut Marks 

Eurosystems OptiSCOUT / Zuend Touch and Cut 

The dimension of the barcode can 
be configured on the Device Op-
tions tab in the cut environment. 
The automatic cut marks are confi-
gured on the Extended tab. 

 

 

 
MGE i-Cut Barcode 

The dimension of the barcode as 
well as the number of the auto-
matic cut marks can be confi-
gured on the Device Options tab 
in the cut environment. 
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Mutoh AL3 

There is no additional configura-
tion to the standard cut mark 
configuration on the Extended 
tab in the cut environment availa-
ble. 

 

 

 
Mutoh Barcode AL5/MF 

There is no additional configuration to the standard cut mark configuration on the Extended 
tab in the cut environment available. 

Please note that the sample above is rotated by 90°. 

 
Mutoh Barcode 

There is no additional configura-
tion to the standard cut mark 
configuration on the Extended 
tab in the cut environment availa-
ble. 
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Summa OPOS XY 

There is no additional configura-
tion to the standard cut mark con-
figuration on the Extended tab in 
the cut environment available. 

The line at the top of the job is 
meant to help adjusting the cut-
ting when the media is distorted 
after printing. 

 
Summa OPOS Barcode / Summa OPOS Barcode XY 

There is no additional configuration 
to the standard cut mark configu-
ration on the Extended tab in the 
cut environment available. 

The line at the top of the job is 
needed for finding the barcode. 
The “XY” driver will also use it as 
help to adjust the cutting when the 
media is distorted after printing. 
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